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Preface

Thank you for purchasing the DocuPrint C3055/C3055 DX. 
This guide describes the software included on the PostScript Driver Library CD-ROM 
and how to install and configure a PostScript print driver on your computer.
To get the most out of this printer and to use it effectively, please read this guide before 
use. 
This guide assumes you are familiar with your operating system (Microsoft® Windows® 
or Macintosh® Mac OS®), network environment, and the basic operation of the printer. 
Please refer to the User Guide for the PostScript-related menus that appear on the 
printer’s control panel.
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Types of Manuals

The following manuals are available for this printer.

NOTE: To view PDF files, you must have Adobe® Acrobat® Reader® or Adobe® 
Reader® installed on your computer. If you do not have it installed, install it from the 
CD-ROM of the driver CD kit.

Setup Guide Provides step-by-step instructions on how to set up your 
printer.

Quick Reference Guide Provides information such as how to get ready to print, 
basic operating instructions, and troubleshooting tips. 
Refer to the User Guide for more details and information 
not covered in this guide.

User Guide (PDF) Describes how to get ready to print and set various print 
features. It also covers the control panel menus, 
troubleshooting tips, and maintenance information.
This guide is on the CD-ROM of the driver CD kit under 
[Model-specific Manual (PDF Document)]. 

CD-ROM 
Documentation (HTML)

Describes how to set up the printer’s operating 
environment and to install a print driver and various Fuji 
Xerox software. 
This guide is on the CD-ROM of the driver CD kit.

Emulation Setting 
Guide (PDF) 

Contains information about the ESC/P and PCL emulation 
modes.
This guide is on the CD-ROM of the driver CD kit under 
[Model-specific Manual (PDF Document)].

PostScript User Guide
(this guide)

Describes how to set up your printer as a PostScript 
printer and the features that can be configured on your 
print driver.
This guide is on the PostScript Driver Library CD-ROM.

Installation guides for 
the optional 
accessories

Most optional accessories (sold separately) come with 
installation guides.
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Conventions

The following conventions are used throughout this guide:

Square brackets ([   ]) Indicate the names of windows, dialog boxes, tabs, buttons, 
features, menus, setting items, and options that appear on 
your computer screen.
For example:

• You can also browse the folder by clicking [Browse].

Less-than sign (>) Indicates the hierarchies of the menus, setting items, and 
options that appear on your computer screen. 
For example:

• [RGB Color Temperature] can be configured when the 
[Paper/Output] tab > [Output Color] is set to [Color].

Italic typeface Indicates references to other sections and chapters.
For example:

• See Print Driver Properties on page 10 to configure the 
print driver.

Note A statement that provides additional information.
For example:
NOTE: Clicking the [Defaults] button restores the defaults.
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Organization

This guide is organized into the following chapters. The summary of each chapter is as 
follows:

Chapter 1
Installation and Configuration on 
Windows 95/98/Me

Describes how to install and configure a 
PostScript print driver on Windows 95, 
Windows 98, or Windows Me.

Chapter 2
Installation and Configuration on 
NT 4.0

Describes how to install and configure a 
PostScript print driver on Windows NT 4.0.

Chapter 3
Installation and Configuration on 
Windows 2000/XP/
Windows Server 2003

Describes how to install and configure a 
PostScript print driver on Windows 2000, 
Windows XP, or Windows Server 2003.

Chapter 4
Installation and Configuration on 
Mac OS

Describes how to install and configure a 
PostScript print driver on Mac OS.

Chapter 5
Barcode Settings 

Contains information such as the types of 
barcode supported by the printer, character 
codes assigned to barcode characters, and 
print sizes of barcodes.

Chapter 6
Appendix

Provides the list of PostScript fonts available on 
the printer. It also describes the notes and 
restrictions that apply to the printer.
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1 Installation and Configuration on 
Windows 95/98/Me

This chapter includes the following information:

• About the Software
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
– Installation Procedure

• Configuring the Print Driver
– [Configuration] tab
– [Options] tab
– [Color Settings] tab
– [Output Settings] tab

• Using the Online Help

About the Software

This section describes the software for Windows 95, Windows 98, and Windows Me 
included on the PostScript Driver Library CD-ROM.

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Windows 95, Windows 98, or Windows Me. 
AdobePS 4.5.3 and PPD files - Adobe PostScript print driver and PPD files for 
Windows 95, Windows 98, and Windows Me.
ATM (Adobe Type Manager) ver. 4.0 - Allows you to install font typefaces and activate 
and manage fonts.
Adobe Screen Fonts (TrueType/PostScript) - Contains 136 screen fonts (19 
TrueType fonts and 117 PostScript fonts) that are compatible with the printer fonts. Use 
ATM to install the PostScript fonts. To print these fonts, install AdobePS 4.5.3.
Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing 
platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
driver. Be sure to read this before using the print driver.
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Hardware/Software Requirements
The system requirements for the print driver for Windows 95, Windows 98, or Windows 
Me are as follows:

Computer System
Personal computer on which Windows 95, Windows 98, or Windows Me is installed.

Basic Software
Windows 95, Windows 98, or Windows Me

Installing the Print Driver

This section describes how to install AdobePS 4.5.3 on Windows 95, Windows 98, or 
Windows Me.
The following procedure uses Windows 98 as an example.
NOTE: To cancel the installation, click [Cancel] in a dialog box displayed during the 
installation. To cancel the settings in a dialog box and return to the previous dialog 
box, click [Back].

Installation Procedure

1. Start Windows 98.

2. From the [Start] menu, select [Settings] and click [Printers].

3. In the [Printers] window, double-click [Add Printer].

4. Click [Next]. 
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5. If the printer is directly connected to your computer, select [Local printer]. 
Otherwise, select [Network printer].
After selecting the connection method, select [Next]. 
In this example, we will select [Local printer].
NOTE: When [Network printer] is selected, specify the path to the printer in the 
network path or queue name box.

6. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive.

7. Click [Have Disk]. 
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8. In the [Copy manufacturer’s files from:] box, enter the drive in which the CD-ROM 
is located (example: "E:"). After the drive name, enter 
“\English\DPC3055\Win9x_Me”, and then click [OK].
NOTE: You can also browse the folder by clicking [Browse].

9. From [Printers], select the model of your printer, and then click [Next].

10. Select the port you want to use and click [Next]. 
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11. Enter a name for your printer, specify whether to use the printer as the default 
printer, and then click [Next].

12. Specify whether to print a test page and click [Finish].

The installation begins.
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13. Read [End User License Agreement]. If you accept the license agreement, click 
[Agree].
If you clicked [Disagree], see When [Disagree] is Clicked in the License Agreement 
on page 17. 

14. Check if the test page is printed and the printer is added to the [Printers] window. 

This completes the installation of the print driver. Remove the CD-ROM from the 
CD-ROM drive.
To configure the print driver, see Configuring the Print Driver on page 18.
Store the CD-ROM in a safe place.
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When [Disagree] is Clicked in the License Agreement
The following dialog box appears if you click [Disagree] in [End User License 
Agreement].

Click [No] to continue the installation.
Click [Yes] to cancel the installation. This operation adds the printer to the [Printers] 
window but does not correctly install the print driver.
To correctly install the print driver, right-click the printer icon added to the [Printer] 
window and click [Properties] in the displayed menu. The printer’s properties dialog box 
appears. Display the [Re-installation] tab and follow the instructions on the tab.
When the re-installation is complete, go on to configure the print driver.
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Configuring the Print Driver

This section describes the following tabs in the print driver properties that are specific 
to this printer. 

• [Configuration] tab

• [Options] tab

• [Color Settings] tab

• [Output Settings] tab
NOTE: See the online help for details about other tabs.

To view the print driver properties, select the printer icon in the [Printers] window, and 
then select [Properties] from the [File] menu.

[Configuration] Tab
The following explains how to configure the [Configuration] tab.
Select an item you want to configure in [Features List] and select its option from the 
[Settings for] box.

NOTE: Clicking the [Defaults] button restores the defaults. 
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Setting Items
Bypass Feed Orientation - Sets the orientation of the paper when printing from the 
bypass tray. When loading the paper with one of the short edges facing into the bypass 
tray, select [Portrait]. When loading the paper with one of the long edges facing into the 
bypass tray, select [Landscape]. If the orientation can only be one way or the other 
depending on the paper size, the actual orientation of the paper overrides this setting.
Collated - Sets whether or not to collate multiple-page documents.
Feed Separators from - Sets the paper tray for separators when using the 
Transparency Separators feature. Selecting [Auto] uses the paper tray selected on the 
printer.
Print on Separators - Sets whether or not to print on separators. Selecting [Off] inserts 
blank separators. Selecting [On] prints the same contents printed on transparencies to 
separators.
Substitute Tray - Sets what action to take when the [Paper] tab > [Paper source] is set 
to [Auto Select Tray] and the paper of the size you requested is not loaded in the printer.

Use Printer Settings - Uses the settings configured on the printer. 
Display Message - Displays a message on the control panel that prompts you to 
load the paper. Your document will not be printed until you load the paper in the 
printer.
Use Nearest Size (Adjust to Fit) - Uses the paper of the nearest size and prints the 
document at 100% magnification or at a reduced magnification if necessary. 
Use Nearest Size (No Zoom) - Uses the paper of the nearest size and prints the 
document at 100% magnification.
Use Larger Size (Adjust to Fit) - Uses the paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.
Use Larger Size (No Zoom) - Uses the paper of a larger size and prints the 
document at 100% magnification.
Feed from Bypass Tray - Feeds the paper from the bypass tray when it is not 
loaded in the paper trays.

Custom Paper Auto Orientation - If printing on user-defined paper, selecting [On] 
corrects the orientation of the paper. If your document was printed 90 degrees rotated 
on the paper, set this feature to [On].
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
Selecting [On] artificially enhances resolution by smoothing out the edges of images. 
Images (bitmaps) that consist of rough dots may not be reproduced with smooth 
gradations. In such case, set this feature to [Off]. Selecting [On] or [Off] does not affect 
print speed.
Draft Mode - Selecting [On] prints with less toner and thus the colors become lighter. 
Use this feature to save toner when printing documents that do not require high image 
quality.
Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Halftone Screen Lock - Sets halftone screens. Selecting [On] prioritizes the settings 
on the printer over the settings on the application.
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CID Font - Sets whether to use only CID fonts or both CID and OCF fonts. When using 
only CID fonts, select [CID Native]. When using both CID and OCF fonts, select [OCF 
Compatible].
NOTE:  [CID Font] appears only when the Japanese font kit (optional) is installed.

Brightness - Sets the overall brightness of the output.
RGB Color Correction - Sets the color correction method for the RGB images on your 
document.

Perceptual - Optimizes the rendering of photographic images by preserving all tonal 
gradations.
Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.
Relative Colorimetric - Preserves in-gamut colors and represents out-of-gamut 
colors by the closest match.
Absolute Colorimetric - Does not map the white in the images to the white of the 
output paper. Depending on the [RGB Color Temperature] setting, the white in the 
images may be printed with a tint of color.

RGB Profile - Sets RGB profile. The [RGB Profile] setting will be applied in conjunction 
with the [RGB Color Correction] setting. [Adobe RGB (1998)] is the RGB profile of 
Adobe Systems Incorporated. [Adobe RGB (1998)] may not accurately reproduce the 
tones of highly saturated graphics.
RGB Color Temperature - Adjusts the color temperature of your monitor to match the 
on-screen colors to the printed output colors. 

5000K(D50) - Colors become slightly more yellowish than [6500K (D65)].
9300K - Colors become slightly more bluish than [6500K (D65)].

Available Printer Memory - Sets the available printer memory in kilo-bytes. This 
setting does not need to be changed under normal circumstances. The value can be 
an integer between 0 and 200,000. 
Available Font Cache - Sets the available font cache in kilo-bytes. This setting does 
not need to be changed under normal circumstances. The value can be an integer 
between 0 and 25,600.
Account Mode - Sets whether to allow all users or only the administrator to change the 
login settings. 
NOTE: When the user who is logged onto the computer does not have access rights 
to the printer settings, [Account Mode] is grayed out and cannot be changed. 

Detailed User Settings - This button appears when [Account Mode] is selected. 
Clicking the button displays the [Detailed User Settings] dialog box.

Use Default User Settings - Sets whether to use the login settings in this dialog box 
every time you request a print job.

-  Specify User ID - Sets the method of specifying a user ID. 
-  User ID - Sets a user ID with up to 32 alphanumeric characters.
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-  Password - Sets the password for the user ID using 4 to 12 alphanumeric 
characters.

Prompt User for Settings - Selecting this check box displays the [Enter User 
Details] dialog box every time you request a print job. Your job will be printed if you 
enter the user ID and password in the dialog box.

-  Display Previous User Details - Selecting the check box saves the settings in 
the [Enter User Details] dialog box and displays them as the defaults the next 
time you display the dialog box. 

-  Hide User ID(***) - Selecting the check box hides the user ID behind asterisks.



Installation and Configuration on Windows 95/98/Me

22

[Options] Tab 
The following explains how to configure the [Options] tab. You must correctly configure 
this tab to print properly.
Select an item you want to configure in [Hardware Options] and select its option from 
the [Settings for] box. 

NOTE: Clicking the [Default] button restores the defaults.

Setting Items
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Hard Disk - Sets whether or not the hard disk is installed in the printer. 
Duplex Module - Sets whether or not the duplex unit is installed in the printer. 
Memory - Sets the memory capacity of the printer. 
NOTE: The duplex unit comes standard on the DocuPrint C3055 DX. If your printer is 
C3055 DX, [Duplex Module] does not appear on the [Options] tab.
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[Color Settings] Tab
The following explains how to configure the [Color Settings] tab.

NOTE:  Clicking the [Defaults] button restores the defaults.

Setting Items
Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toners when printing. [Black and White] uses only the K 
(black) toner. 
Image Quality - Sets whether to print in [High Speed] or [High Quality] mode. [High 
Quality] may reduce print speed when compared to [High Speed].
Image Types - Sets the type of your document.

Standard - Optimizes the printing of business documents that consist of texts and 
graphs.
Photos - Suitable for printing photographic images and optimizes the reproduction 
of gradations. This is ideal for images represented in sRGB. 
Presentation - Suitable for printing presentation materials that need vibrant colors.
Web Pages - Suitable for printing images displayed on your computer screen, such 
as web pages.
Off - Does not perform color correction.

NOTE: [Image Types] cannot be configured when [Output Color] is set to [Black and 
White].
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Advanced - Displays the [Advanced] dialog box.
Screen - Adjusts the image quality of your document. 

-  Auto - Automatically adjusts the image quality based on the type of the 
document.

-  Fineness - Optimizes the reproduction of texts and lines.
-  Gradation - Optimizes the reproduction of charts and graphs.
-  Standard - Optimizes the reproduction of photographic images.

RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the 
value, the darker the output. 
NOTE: [RGB Gamma Correction] cannot be configured when [Image Types] is set 
to [Off].

Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
setting does not apply to images.
Display warning message about Color Settings - When the [Graphics] tab > 
[Image color matching] is set to [Allow image color matching] or [Always use image 
color matching], selecting the check box displays a dialog box that allows you to 
optimize the "Image Color Matching (ICM)" feature.
NOTE: On Windows 98/ME, [Image Color Matching] appears on the [Graphics] tab 
only when ICC profile is set on the [Color Settings] tab. 



Installation and Configuration on Windows 95/98/Me

25

[Output Settings] Tab
The following explains how to configure the [Output Settings] tab. 

Setting Items
Job Type - Sets the type of your print job to [Normal Print], [Secure Print], or [Sample 
Print].

Normal Print - Prints a job without using the Secure Print or Sample Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Print - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. If you set the print quantity to 1, this 
setting automatically changes to [Normal Print].

NOTE: To select [Secure Print], the [Options] tab > [Hard Disk] must be set to 
[Available]. To select [Sample Print], the [Options] tab > [Hard Disk] must be set to 
[Available] and the [Configuration] tab > [Collated] must be set to [On].

User ID - Sets the user ID for the Secure Print or Sample Print feature with up to 8 
alphanumeric characters.
Password - Sets the password associated with the user ID for the Secure Print feature. 
The password can be up to 12 alphanumeric characters. Asterisks (***) appear instead 
of text as you enter the password in this text box.
Retrieve Document Name - Sets the method of naming the document that will be 
stored in the printer using the Secure Print or Sample Print feature. [Auto Retrieve] 
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automatically retrieves the document name from the application from which the 
document will be printed. If the name exceeds 12 alphanumeric characters, only the 
first 12 characters will be valid.
Document Name - When [Retrieve Document Name] is set to [Enter Document 
Name], enter the document name with up to 12 alphanumeric characters.
Fit to New Paper Size - Sets the size of the output paper. The document will be 
automatically reduced/enlarged based on this setting and the [Paper size] setting on 
the [Paper] tab.
For example, the document will be enlarged if the [Paper] tab > [Paper size] is set to 
[B5] and the [Output Settings] tab > [Fit to New Paper Size] is set to [A4].
[Same as Paper Size] uses the paper size specified on the application.
Display warning message about Output Settings - When printing your document, 
the print driver checks if the [Fit to New Paper Size] setting is consistent with other 
settings. When there is a conflict, selecting this check box displays the [Conflicts] dialog 
box. Leaving the check box blank does not display the dialog box and automatically 
changes the [Fit to New Paper Size] setting to resolve the conflict. 
Image Rotation 180 Degrees - Selecting the check box rotates the landscape or 
portrait pages in your document by 180 degrees. When the [Graphics] tab > [Layout] is 
set to an option other than [1-up], this rotates all pages by 180 degrees.
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Using the Online Help

This section describes how to use the online help. 

1. Click the [ ] button on the print driver dialog box. The [?] mark appears next to 
your mouse pointer. Then, click an item you need help with. The description of the 
item pops up. When you are finished reading the description, click anywhere on 
the pop-up window to close it. 

2. Click the [Help] button on the print driver dialog box. The description of the tab that 
is currently displayed appears.

1

2
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2 Installation and Configuration on 
Windows NT 4.0

This chapter contains the following information:

• About the Software
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
– Installation Procedure

• Configuring the Print Driver
– [Device Settings] tab
– [Configuration] tab
– [Advanced] tab
– [Paper/Output] tab
– [Image Options] tab
– [Layout] tab

• Using the Online Help

About the Software

This section describes the software for Windows NT 4.0 included on the PostScript 
Driver Library CD-ROM.

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Windows NT 4.0. 
AdobePS 5.2.2 and PPD files - Adobe PostScript print driver and PPD files for 
Windows NT 4.0.
ATM (Adobe Type Manager) ver. 4.0 - Allows you to install font typefaces and activate 
and manage fonts.
Adobe Screen Fonts (TrueType/PostScript) - Contains 136 screen fonts (19 
TrueType fonts and 117 PostScript fonts) that are compatible with the printer fonts. Use 
ATM to install the PostScript fonts. To print these fonts, install AdobePS 5.2.2.
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Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing 
platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
driver. Be sure to read this before using the print driver.

Hardware/Software Requirements
The system requirements for the print driver for Windows NT 4.0 are as follows:

Computer System
Personal computer on which Windows NT 4.0 is installed.

Basic Software
• Windows NT Workstation 4.0

• Windows NT Server 4.0 (Service Pack 6a or later)

Installing the Print Driver

This section describes how to install AdobePS 5.2.2 on Windows NT 4.0.
NOTE: To cancel the installation, click [Cancel] in a dialog box displayed during the 
installation. To cancel the settings in a dialog box and return to the previous dialog 
box, click [Back].

Installation Procedure

1. Start Windows NT 4.0.

NOTE: When installing the print driver, make sure you are logged on as a Power 
User group member or as an administrator. Refer to the Windows NT 4.0 
documentation for information about the Power User group.

2. From the [Start] menu, select [Settings] and click [Printers].

3. In the [Printer] window, double-click [Add Printer].
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4. If the printer is directly connected to your computer or to a network in a TCP/IP 
(LPD) environment, select [My Computer]. Otherwise, select [Network printer 
server]. 
After selecting the connection method, select [Next]. 
In this example, we will select [My Computer].
NOTE: When [Network printer server] is selected, specify the target printer in the 
[Connect to Printer] dialog box.

5. Select the port you want to use and click [Next]. 

6. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive.
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7. Click [Have Disk]. 

8. In the [Copy manufacturer’s files from:] box, enter the drive in which the CD-ROM 
is located (example: "E:"). After the drive name, enter 
“\English\DPC3055\WinNT40”, and then click [OK].
NOTE: You can also browse the folder by clicking [Browse].

9. From [Printers], select the model of your printer, and then click [Next].
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10. Enter a name for your printer, specify whether to use the printer as the default 
printer, and then click [Next].

11. Select [Not shared] and click [Next].
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12. Specify whether to print a test page and click [Finish].

The installation begins.

13. Read [End User License Agreement]. If you accept the license agreement, click 
[Agree].
If you clicked [Disagree], see When [Disagree] is Clicked in the License Agreement 
on page 35.
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14. Check if the test page is printed and the printer is added to the [Printers] window.

This completes the installation of the print driver. Remove the CD-ROM from the CD-
ROM drive.
To configure the print driver, see Configuring the Print Driver on page 36.
Store the CD-ROM in a safe place.

When [Disagree] is Clicked in the License Agreement
The following dialog box appears if you click [Disagree] in [End User License 
Agreement].

Click [No] to return to Step 13 and continue the installation.
Click [Yes] to cancel the installation. This operation adds the printer to the [Printers] 
window but does not correctly install the print driver.
To correctly install the print driver, select the printer icon added to the [Printers] window 
and select [Properties] from the [File] menu. The printer’s properties dialog box 
appears. Display the [Re-installation] tab and follow the instructions on the tab.
When the re-installation is complete, go on to configure the print driver. 
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Configuring the Print Driver

This section describes the following tabs in the print driver properties that are specific 
to this printer.

• [Device Settings] tab

• [Configuration] tab

• [Advanced] tab

• [Paper/Output] tab

• [Image Options] tab

• [Layout] tab
NOTE: See the online help for details about other tabs.

To view the [Device Settings] or [Configuration] tab, select the printer icon in the 
[Printers] window, and then select [Properties] from the [File] menu.
To view the [Advanced], [Paper/Output], [Image Options], or [Layout] tab, select the 
printer icon in the [Printers] window, and then select [Document Defaults] from the [File] 
menu.
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[Device Settings] Tab
The following explains [Installable Options] on the [Device Settings] tab. You must 
correctly configure [Installable Options] to print properly.
Select the item you want to configure in [Installable Options] and select its option from 
[Change ’xxx’ Setting] (where xxx is the name of the selected item).
. 

Setting Items
Memory - Sets the memory capacity of the printer. 
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Hard Disk - Sets whether or not the hard disk is installed in the printer. 
Duplex Module - Sets whether or not the duplex unit is installed in the printer. 
Color Mode - Selecting [Black] fixes the [Image Options] tab > [Output Color] to [Black 
and White] and disables [Color]. 
NOTE: The duplex unit comes standard on the DocuPrint C3055 DX. If your printer is 
C3055 DX, [Duplex Module] does not appear under [Installable Options].
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[Configuration] Tab
The following explains how to configure the [Configuration] tab. 

NOTE: Clicking the [Defaults] button restores the defaults.

Setting Items
Manage Accounting - Selecting the check box uses the user authentication (login) 
feature.
Account Mode - Sets whether to allow all users or only the administrator to change the 
login settings.
NOTE: If the user who is logged onto the computer does not have access rights to the 
printer settings, [Account Mode] is grayed out and cannot be changed. When the 
[High Speed Printing] check box is selected, [Account Mode] is set to [Administrator] 
and is grayed out. Clearing the check box allows you to change the setting.

Detailed User Settings - Displays the [Detailed User Settings] dialog box.
Use Default User Settings - Sets whether or not to use the login settings in this 
dialog box every time you request a print job.

-  Specify User ID - Sets the method of specifying a user ID. 
-  User ID - Sets a user ID with up to 32 alphanumeric characters.
-  Password - Sets the password for the user ID using 4 to 12 alphanumeric 

characters.
Prompt User for Settings - Selecting this check box displays the [Enter User 
Details] dialog box every time you request a print job. Your job will be printed if you 
enter the user ID and password in the dialog box.
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NOTE: When the [High Print Speed] check box is selected, [Prompt User for 
Settings] is grayed out and cannot be changed.

-  Display Previous User Details - Selecting the check box saves the settings in 
the [Enter User Details] dialog box and displays them as the defaults the next 
time you display the dialog box. 

-  Hide User ID(***) - Selecting the check box hides the user ID behind asterisks.
High Speed Printing - Increases the print speed of applications that directly create 
PostScript files. This feature should not be used in normal circumstances.
Get Information from Printer - If the printer is networked using TCP/IP or IPX, clicking 
[Get Information from Printer] checks the options installed on the printer and 
automatically updates [Installable Options] on the [Device Settings] tab. Clicking the 
button also obtains the printer’s address and displays it in [Network Address]. 
When your printer is a local printer, [Get Information from Printer] cannot be used, and 
you must manually set the information on the print driver. 
To use this feature, you must enable the printer’s SNMP port.
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[Advanced] Tab
The following explains how to configure the [Advanced] tab in the Default dialog box.
Select an item you want to configure and select its option from [Change ’xxx’ Setting] 
(where xxx is the name of the selected item).

Setting Items
Transparency Separators

Feed Separators from - Sets the paper tray for separators when using the 
Transparency Separators feature. Selecting [Auto] uses the paper tray selected on 
the printer. 
Print on Separators - Sets whether or not to print on separators. Selecting [Off] 
inserts blank separators. Selecting [On] prints the same contents printed on 
transparencies to separators.

Images
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
Selecting [On] artificially enhances resolution by smoothing out the edges of 
images. Images (bitmaps) that consist of rough dots may not be reproduced with 
smooth gradations. In such case, set this feature to [Off]. Selecting [On] or [Off] does 
not affect print speed.
Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
setting does not apply to images.
Halftone Screen Lock - Sets halftone screens. Selecting [On] prioritizes the 
settings on the printer over the settings on the application.
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Details 
Image Rotation 180 Degrees - Selecting the check box rotates the landscape or 
portrait pages in your document by 180 degrees. When the [Layout] tab > [Multiple-
Up] is set to an option other than [1 Page Up], this rotates all pages by 180 degrees.
Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Draft Mode - Selecting [On] uses less toner and thus the colors become lighter. Use 
this feature to save toner when printing documents that do not require high image 
quality.
Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

-  Use Printer Settings - Uses the settings configured on the printer. 
-  Display Message - Displays a message on the control panel that prompts you 

to load the paper. Your document will not be printed until you load the paper in 
the printer.

-  Use Nearest Size (Adjust to Fit) - Uses the paper of the nearest size and 
prints the document at 100% magnification or at a reduced magnification if 
necessary. 

-  Use Nearest Size (No Zoom) - Uses the paper of the nearest size and prints 
the document at 100% magnification.

-  Use Larger Size (Adjust to Fit) - Uses the paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.

-  Use Larger Size (No Zoom) - Uses the paper of a larger size and prints the 
document at 100% magnification.

-  Feed from Bypass Tray - Feeds the paper from the bypass tray when it is not 
loaded in the paper trays.

Custom Paper Auto Orientation - If printing on user-defined paper, selecting [On] 
corrects the orientation of the paper. If your document was printed 90 degrees 
rotated on the paper, set this feature to [On].
CID Font - Sets whether to use only CID fonts or both CID and OCF fonts. When 
using only CID fonts, select [CID Native]. When using both CID and OCF fonts, 
select [OCF Compatible].
NOTE:  [CID Font] appears only when the Japanese font kit (optional) is installed.

About - Displays the version information of the print driver.
Help - Displays the online help for the print driver.
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[Paper/Output] Tab
The following explains how to configure the [Paper/Output] tab in the Default dialog 
box.
 

Setting Items
Job Type -Sets the type of your print job to [Normal Print], [Secure Print], or [Sample 
Print].

Normal Print - Prints a job without using the Secure Print or Sample Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Print - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. If you set the print quantity to 1, this 
setting automatically changes to [Normal Print].
NOTE: To select [Secure Print] and [Sample Print], the [Device Settings] tab > 
[Hard Disk] must be set to [Available]. 

Setup - This button becomes active when [Job Type] is set to [Secure Print] or [Sample 
Print]. Clicking the button displays the [Secure Print] or [Sample Print] dialog box. 
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User ID - Sets the user ID for the Secure Print or Sample Print feature with up to 8 
alphanumeric characters.
Password - Sets the password associated with the user ID for the Secure Print 
feature. The password can be up to 12 alphanumeric characters. Asterisks (***) 
appear instead of text as you enter the password in this text box.
NOTE: [Password] appears only on the [Secure Print] dialog box.

Retrieve Document Name - Sets the method of naming the document that will be 
stored in the printer using the Secure Print or Sample Print feature. [Auto Retrieve] 
automatically retrieves the document name from the application from which the 
document will be printed. If the name exceeds 12 alphanumeric characters, only the 
first 12 characters will be valid.
Document Name - When [Retrieve Document Name] is set to [Enter Document 
Name], enter the document name with up to 12 alphanumeric characters.

2 Sided Print - Sets whether to print your job 1-sided or 2-sided. When printing 2-sided, 
select [Flip on long edge] or [Flip on short edge].
Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toners when printing. [Black and White] uses only the K 
(black) toner.
Paper Size - Sets the paper size of your document.
Paper Source - Sets the paper tray to be used for printing the document. 
Feed Orientation for Bypass Tray - Sets the orientation of the paper when printing 
from the bypass tray. When loading the paper with one of the short edges facing into 
the bypass tray, select [Portrait]. When loading the paper with one of the long edges 
facing into the bypass tray, select [Landscape]. If the orientation can only be one way 
or the other depending on the paper size, the actual orientation of the paper overrides 
this setting.
Paper Type - Sets the type of paper to be used for printing the document. Selecting 
[None] uses the paper type selected on the printer. 
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[Image Options] Tab
The following explains how to configure the [Image Options] tab in the Default dialog 
box.
 

Setting Items
Image Quality - Sets whether to print in [High Speed] or [High Quality] mode. 
NOTE: [High Quality] may reduce print speed when compared to [High Speed].

Brightness - Sets the overall brightness of the output.
Basic Settings - Allows you to configure the basic RGB color correction settings.
Advanced Settings - Allows you to configure the advanced RGB color correction 
settings.
Image Adjustment - Displays the [Image Adjustment] dialog box.

RGB Color Correction - Sets the color correction method for the RGB images on 
your document. You can configure this when [Advanced Settings] is selected.

-  Perceptual - Optimizes the rendering of photographic images by preserving all 
tonal gradations.

-  Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.

-  Relative Colorimetric - Preserves in-gamut colors and represents out-of-
gamut colors by the closest match.
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-  Absolute Colorimetric - Does not map the white in the images to the white of 
the output paper. Depending on the [RGB Color Temperature] setting, the 
white in the images may be printed with a tint of color.

NOTE: [RGB Color Correction] cannot be configured when the [Paper/Output] tab 
> [Output Color] is set to [Black and White].

Enter RGB profile - Sets RGB profile. The [Enter RGB profile] setting will be applied 
in conjunction with the [RGB Color Correction] setting. [Adobe RGB (1998)] is the 
RGB profile of Adobe Systems Incorporated. [Adobe RGB (1998)] may not 
accurately reproduce the tones of highly saturated graphics.
NOTE: [Enter RGB profile] can be configured only when the [Paper/Output] tab > 
[Output Color] is set to [Color] and the [Image Options] tab > [Advanced Settings] is 
selected.

RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the 
value, the darker the output. 
NOTE: [RGB Gamma Correction] can be configured only when the [Paper/Output] 
tab > [Output Color] is set to [Color].

RGB Color Temperature - Adjusts the color temperature of your monitor to match 
the on-screen colors to the printed output colors.

-  5000K(D50) - Colors become slightly more yellowish than [6500K (D65)].
-  9300K - Colors become slightly more bluish than [6500K (D65)].

NOTE: [RGB Color Temperature] can be configured only when the [Paper/Output] 
tab > [Output Color] is set to [Color] and the [Image Options] tab > [Advanced 
Settings] is selected.

Screen - Adjusts the image quality of your document. 
Auto - Automatically adjusts the image quality based on the type of the document.
Fineness - Optimizes the reproduction of texts and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

Color Balance - Displays the [Color Balance] dialog box. 
Adjust Color Balance - Selecting the check box allows you to adjust the density of 
the CMYK (cyan/magenta/yellow/black) toners.
To adjust the density of a color, select the color from [Target Color] and specify its 
density for [Highlights], [Midtones], and [Shadows].
NOTE: Only [Black] can be adjusted when the [Paper/Output] tab > [Output Color] 
is set to [Black and White].
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[Layout] Tab
The following explains how to configure the [Layout] tab in the Default dialog box.
 

Setting Items
Multiple-Up - Prints multiple pages onto one sheet of paper.
NOTE: [Multiple-Up] is displayed only when the [Device Settings] tab > [Duplex 
Module] is set to [Available] and the [Advanced] tab > [Enable advanced printing 
feature] is selected. 

Draw Outlines - Prints each page with a frame when [Multiple-Up] is enabled.
Fit to New Paper Size - Sets the size of the output paper. When this setting is different 
from [Paper Size] on the [Paper/Output] tab, the document will be reduced /enlarged to 
fit to the paper size selected here.
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Using the Online Help

This section describes how to use the online help.

1. Click the [ ] button on the print driver dialog box. The [?] mark appears next to 
your mouse pointer. Then, click an item you need help with. The description of the 
item pops up. When you are finished reading the description, click anywhere on 
the pop-up window to close it.

2. Click the [Help] button on the print driver dialog box. The description of the tab that 
is currently displayed appears. 

1

2
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3 Installation and Configuration on 
Windows 2000/XP/Windows Server 
2003

This chapter contains the following information:

• About the Software
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
– Installation Procedure

• Configuring the Print Driver
– [Device Settings] tab
– [Configuration] tab
– [Advanced] tab
– [Paper/Output] tab
– [Image Options] tab
– [Layout] tab

• Using the Online Help

About the Software

This section describes the software for Windows 2000, Windows XP, and Windows 
Server 2003 included on the PostScript Driver Library CD-ROM.

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Windows 2000, Windows XP, or Windows Server 2003. 
Microsoft PScript 5 and PPD files - Microsoft PScript print driver and PPD files for 
Windows 2000, Windows XP, and Windows Server 2003.
Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing 
platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
driver. Be sure to read this before using the print driver. 
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Hardware/Software Requirements
The system requirements for the print driver for Windows 2000, Windows XP, or 
Windows Server 2003 are as follows:

Computer System
Personal computer on which the Windows 2000, Windows XP, or Windows Server 
2003 is installed.

Basic Software
• Windows 2000 Professional

• Windows 2000 Server

• Windows 2000 Advanced Server

• Windows XP Professional Edition

• Windows XP Home Edition

• Windows Server 2003

Installing the Print Driver 

This section describes how to install MS PScript 5 on Windows 2000, Windows XP, or 
Windows Server 2003.
The following procedure uses Windows XP as an example.
NOTE: To cancel the installation, click [Cancel] in a dialog box displayed during the 
installation. To cancel the settings in a dialog box and return to the previous dialog 
box, click [Back].

Installation Procedure

1. Start Windows XP.

NOTE: When installing the print driver, make sure you are logged on as a Power 
User group member or as an administrator. Refer to the Windows XP 
documentation for information about the Power User group.

2. From the [Start] menu, select [Settings] and click [Printers and Faxes].

3. In the [Printers and Faxes] window, double-click [Add Printer].
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4. Click [Next]. 

5. If the printer is directly connected to your computer or over a network in a TCP/IP 
(LPD) environment, select [Local printer attached to this computer].
Otherwise, select [A network printer, or a printer attached to another computer]. 
After selecting the connection method, click [Next]. 
In this example, we will select [Local printer attached to this computer].
NOTE: When [Local printer attached to this computer] is selected, clear the 
[Automatically detect and install my Plug and Play printer] check box. When [A 
network printer, or a printer attached to another computer] is selected, specify the 
printer in the [Connect to printer] dialog box.
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6. Select the port you want to use and click [Next].

When the printer is installed in a TCP/IP(LPD) environment:
1) Click [Create a new port].
2) Select [Standard TCP/IP Port] from the [Type of port] list and click [Next].
3) Click [Next].
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4) Enter the IP address of the printer in [Printer Name or IP Address] and click 
[Next]. 

Click [Finish] in the displayed dialog box.

7. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 

8. Click [Have Disk]. 
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9. In the [Copy manufacturer’s files from:] box, enter the drive in which the CD-ROM 
is located (example: "E:"). After the drive name, enter 
“\English\DPC3055\Win2K_XP”, and then click [OK].
NOTE: You can also browse the folder by clicking [Browse]. 

10. From [Printers], select the model of your printer, and then click [Next]. 
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11. Enter a name for your printer, specify whether to use the printer as the default 
printer, and then click [Next]. 

12. Select [Do not share this printer] and click [Next]. 
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13. Specify whether to print a test page and click [Next]. 

14. Click [Finish]. 

NOTE: If the message "The software you are installing has not passed Windows 
Logo testing to verify its compatibility with Windows XP" appears, click [Continue 
Anyway] to continue the installation.

The installation begins.
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15. Check if the printer is added to the [Printers] window. 

This completes the installation of the print driver. Remove the CD-ROM from the CD-
ROM drive.
To configure the print driver, see "Configuring the Print Driver" (P. 58). 
Store the CD-ROM in a safe place.
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Configuring the Print Driver

This section describes the following tabs in the print driver properties that are specific 
to this printer.

• [Device Settings] tab

• [Configuration] tab

• [Advanced] tab

• [Paper/Output] tab

• [Image Options] tab

• [Layout] tab
NOTE: See the online help for details about other tabs. 

To view the [Device Settings] or [Configuration] tab, select the printer icon in the 
[Printers] window, and then click [Properties] from the [File] menu.
To view the [Advanced], [Paper/Output], [Image Options], or [Layout] tab, select the 
printer icon in the [Printers] window, and then click [Printing Preferences] from the [File] 
menu.
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[Device Settings] Tab
The following explains [Installable Options] on the [Device Settings] tab. You must 
correctly configure [Installable Options] to print properly.
Select an item you want to configure in [Installable Options] and select its option from 
the menu that appears on the right.

Setting Items
Memory - Sets the memory capacity of the printer. 
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Hard Disk - Sets whether or not the hard disk is installed in the printer. 
Duplex Module - Sets whether or not the duplex unit is installed in the printer. 
Color Mode - Selecting [Black] fixes the [Image Options] tab > [Output Color] to [Black 
and White] and disables [Color].
NOTE: The duplex unit comes standard on the DocuPrint C3055 DX. If your printer is 
C3055 DX, [Duplex Module] does not appear under [Installable Options].
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[Configuration] Tab
The following explains how to configure the [Configuration] tab. 

NOTE: Clicking the [Defaults] button restores the defaults.

Setting Items
Manage Accounting - Selecting the check box uses the user authentication (login) 
feature.
Account Mode - Sets whether to allow all users or only the administrator to change the 
login settings.
NOTE: If the user who is logged onto the computer does not have access rights to the 
printer settings, [Account Mode] is grayed out and cannot be changed. When the 
[High Speed Printing] check box is selected, [Account Mode] is set to [Administrator] 
and is grayed out. Clearing the check box allows you to change the setting.

Detailed User Settings - Displays the [Detailed User Settings] dialog box.
Use Default User Settings - Sets whether or not to use the login settings in this 
dialog box every time you request a print job.

-  Specify User ID - Sets the method of specifying a user ID. 
-  User ID - Sets a user ID with up to 32 alphanumeric characters.
-  Password - Sets the password for the user ID using 4 to 12 alphanumeric 

characters.
Prompt User for Settings - Selecting this check box displays the [Enter User 
Details] dialog box every time you request a print job. Your job will be printed if you 
enter the user ID and password in the dialog box.
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NOTE: When the [High Print Speed] check box is selected, [Prompt User for 
Settings] is grayed out and cannot be changed.

-  Display Previous User Details - Selecting the check box saves the settings in 
the [Enter User Details] dialog box and displays them as the defaults the next 
time you display the dialog box. 

-  Hide User ID(***) - Selecting the check box hides the user ID behind asterisks.
High Speed Printing - Increases the print speed of applications that directly create 
PostScript files. This feature should not be used in normal circumstances.
Get Information from Printer - If the printer is networked using TCP/IP or IPX, clicking 
[Get Information from Printer] checks the options installed on the printer and 
automatically updates [Installable Options] on the [Device Settings] tab. Clicking the 
button also obtains the printer’s address and displays it in [Network Address]. 
When your printer is a local printer, [Get Information from Printer] cannot be used, and 
you must manually set the information on the print driver. 
To use this feature, you must enable the printer’s SNMP port.
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[Advanced] Tab
The following explains how to configure the [Advanced] tab in the Printing Preferences 
dialog box.
Select an item you want to configure and select its option from the menu that appears 
on the right. 
 

Setting Items
Transparency Separators

Feed Separators from - Sets the paper tray for separators when using the 
Transparency Separators feature. Selecting [Auto] uses the paper tray selected on 
the printer. 
Print on Separators - Sets whether or not to print on separators. Selecting [Off] 
inserts blank separators. Selecting [On] prints the same contents printed on 
transparencies to separators.

Images
Image Enhancement - Sets whether or not to use the Image Enhancement feature. 
Selecting [On] artificially enhances resolution by smoothing out the edges of 
images. Images (bitmaps) that consist of rough dots may not be reproduced with 
smooth gradations. In such case, set this feature to [Off]. Selecting [On] or [Off] does 
not affect print speed.
Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
setting does not apply to images.
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Halftone Screen Lock - Sets halftone screens. Selecting [On] prioritizes the 
settings on the printer over the settings on the application.

Details 
Image Rotation 180 Degrees - Selecting the check box rotates the landscape or 
portrait pages in your document by 180 degrees. When the [Layout] tab > [Multiple-
Up] is set to an option other than [1 Page Up], this rotates all pages by 180 degrees.
Skip Blank Pages - Sets whether or not to skip blank pages during printing.
Draft Mode - Selecting [On] uses less toner and thus the colors become lighter. Use 
this feature to save toner when printing documents that do not require high image 
quality.
Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

-  Use Printer Settings - Uses the settings configured on the printer. 
-  Display Message - Displays a message on the control panel that prompts you 

to load the paper. Your document will not be printed until you load the paper in 
the printer.

-  Use Nearest Size (Adjust to Fit) - Uses the paper of the nearest size and 
prints the document at 100% magnification or at a reduced magnification if 
necessary. 

-  Use Nearest Size (No Zoom) - Uses the paper of the nearest size and prints 
the document at 100% magnification.

-  Use Larger Size (Adjust to Fit) - Uses the paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.

-  Use Larger Size (No Zoom) - Uses the paper of a larger size and prints the 
document at 100% magnification.

-  Feed from Bypass Tray - Feeds the paper from the bypass tray when it is not 
loaded in the paper trays.

Custom Paper Auto Orientation - If printing on user-defined paper, selecting [On] 
corrects the orientation of the paper. If your document was printed 90 degrees 
rotated on the paper, set this feature to [On].
CID Font - Sets whether to use only CID fonts or both CID and OCF fonts. When 
using only CID fonts, select [CID Native]. When using both CID and OCF fonts, 
select [OCF Compatible].
NOTE:  [CID Font] appears only when the Japanese font kit (optional) is installed.

About - Displays the version information of the print driver.
Help - Displays the online help for the print driver.
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[Paper/Output] Tab
The following explains how to configure the [Paper/Output] tab in the Printing 
Preferences dialog box. 

Setting Items
Job Type - Sets the type of your print job to [Normal Print], [Secure Print], or [Sample 
Print].

Normal Print - Prints a job without using the Secure Print or Sample Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Print - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. If you set the print quantity to 1, this 
setting automatically changes to [Normal Print].
NOTE: To select [Secure Print] and [Sample Print], the [Device Settings] tab > 
[Hard Disk] must be set to [Available]. 

Setup - This button becomes active when [Job Type] is set to [Secure Print] or [Sample 
Print]. Clicking the button displays the [Secure Print] or [Sample Print] dialog box. 

User ID - Sets the user ID for the Secure Print or Sample Print feature with up to 8 
alphanumeric characters.
Password - Sets the password associated with the user ID for the Secure Print 
feature. The password can be up to 12 alphanumeric characters. Asterisks (***) 
appear instead of text as you enter the password in this text box.
NOTE: [Password] appears only on the [Secure Print] dialog box.
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Retrieve Document Name - Sets the method of naming the document that will be 
stored in the printer using the Secure Print or Sample Print feature. [Auto Retrieve] 
automatically retrieves the document name from the application from which the 
document will be printed. If the name exceeds 12 alphanumeric characters, only the 
first 12 characters will be valid.
Document Name - When [Retrieve Document Name] is set to [Enter Document 
Name], enter the document name with up to 12 alphanumeric characters.

2 Sided Print - Sets whether to print your job 1-sided or 2-sided. When printing 2-sided, 
select [Flip on long edge] or [Flip on short edge].
Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toners when printing. [Black and White] uses only the K 
(black) toner.
Paper Size - Sets the paper size of your document.
Paper Source - Sets the paper tray to be used for printing the document. 
Feed Orientation for Bypass Tray - Sets the orientation of the paper when printing 
from the bypass tray. When loading the paper with one of the short edges facing into 
the bypass tray, select [Portrait]. When loading the paper with one of the long edges 
facing into the bypass tray, select [Landscape]. If the orientation can only be one way 
or the other depending on the paper size, the actual orientation of the paper overrides 
this setting.
Paper Type - Sets the type of paper to be used for printing your document. Selecting 
[None] uses the paper type selected on the printer.
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[Image Options] Tab
The following explains how to configure the [Image Options] tab in the Printing 
Preferences dialog box.
 

Setting Items
Image Quality - Sets whether to print in [High Speed] or [High Quality] mode. 
NOTE: [High Quality] may reduce print speed when compared to [High Speed].

Brightness - Sets the overall brightness of the output.
Basic Settings - Allows you to configure the basic RGB color correction settings.
Advanced Settings - Allows you to configure the advanced RGB color correction 
settings.
Image Adjustment - Displays the [Image Adjustment] dialog box.

RGB Color Correction - Sets the color correction method for the RGB images on 
your document. You can configure this when [Advanced Settings] is selected.

-  Perceptual - Optimizes the rendering of photographic images by preserving all 
tonal gradations.

-  Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.

-  Relative Colorimetric - Preserves in-gamut colors and represents out-of-
gamut colors by the closest match.
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-  Absolute Colorimetric - Does not map the white in the images to the white of 
the output paper. Depending on the [RGB Color Temperature] setting, the 
white in the images may be printed with a tint of color.

NOTE: [RGB Color Correction] cannot be configured when the [Paper/Output] tab 
> [Output Color] is set to [Black and White].

Enter RGB profile - Sets RGB profile. The [Enter RGB profile] setting will be applied 
in conjunction with the [RGB Color Correction] setting. [Adobe RGB (1998)] is the 
RGB profile of Adobe Systems Incorporated. [Adobe RGB (1998)] may not 
accurately reproduce the tones of highly saturated graphics.
NOTE: [Enter RGB profile] can be configured only when the [Paper/Output] tab > 
[Output Color] is set to [Color] and the [Image Options] tab > [Advanced Settings] is 
selected.

RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the 
value, the darker the output. 
NOTE: [RGB Gamma Correction] can be configured only when the [Paper/Output] 
tab > [Output Color] is set to [Color].

RGB Color Temperature - Adjusts the color temperature of your monitor to match 
the on-screen colors to the printed output colors.

-  5000K(D50) - Colors become slightly more yellowish than [6500K (D65)].
-  9300K - Colors become slightly more bluish than [6500K (D65)].

NOTE: [RGB Color Temperature] can be configured only when the [Paper/Output] 
tab > [Output Color] is set to [Color] and the [Image Options] tab > [Advanced 
Settings] is selected.

Screen - Adjusts the image quality of your document. 
Auto - Automatically adjusts the image quality based on the type of the document.
Fineness - Optimizes the reproduction of texts and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

Color Balance - Displays the [Color Balance] dialog box. 
Adjust Color Balance - Selecting the check box allows you to adjust the density of 
the CMYK (cyan/magenta/yellow/black) toners.
To adjust the density of a color, select the color from [Target Color] and specify its 
density for [Highlights], [Midtones], and [Shadows].
NOTE: Only [Black] can be adjusted when the [Paper/Output] tab > [Output Color] 
is set to [Black and White].
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[Layout] Tab
The following explains how to configure the [Layout] tab in the Printing Preferences 
dialog box.
 

Setting Items
Multiple-Up - Prints multiple pages onto one sheet of paper.
NOTE: [Multiple-Up] is displayed only when the [Device Settings] tab > [Duplex 
Module] is set to [Available] and the [Advanced] tab > [Enable advanced printing 
feature] is selected. 

Draw Outlines - Prints each page with a frame when [Multiple-Up] is enabled.
Fit to New Paper Size - Sets the size of the output paper. When this setting is different 
from [Paper Size] on the [Paper/Output] tab, your document will be reduced /enlarged 
to fit to the paper size selected here.
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Using the Online Help

The following explains how to use the online help. 

1. Click the [ ] button on the print driver dialog box. The [?] mark appears next to 
your mouse pointer. Then, click an item you need help with. The description of the 
item pops up. When you are finished reading the description, click anywhere on 
the pop-up window to close it.

2. Click the [Help] button on the print driver dialog box. The description of the tab that 
is currently displayed appears. 

1

2
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4 Installation and Configuration on 
Mac OS

This chapter contains the following information:

• About the Software
– Included Software
– Hardware/Software Requirements

• Installing the Print Driver
– Installation Procedure (Mac OS 9.x or earlier)
– Configuring the PPD File (Mac OS 9.x or earlier)
– Installation Procedure (Mac OS X)
– Adding the Printer (Mac OS X)

• Configuring the Print Driver
– Installable Options
– Printer Specific Options/Printer Features
– Job Type (Mac OS X only)
– Job Accounting (Mac OS X only)

• Installing the Screen Fonts

• Fuji Xerox PS Utility
– Installing Fuji Xerox PS Utility
– Uninstalling Fuji Xerox PS Utility
– Using Fuji Xerox PS Utility

About the Software

This section describes the software for Mac OS included on the PostScript Driver 
Library CD-ROM.

Included Software
The following items are included on the CD-ROM and are required to print PostScript 
documents from Mac OS. 
AdobePS 8.5.1, 8.7.0, and 8.8 and PPD files - The Adobe PostScript print drivers and 
PPD files for Mac OS.
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Fuji Xerox PPD Installer - The PPD install package for Mac OS X 10.1.5 and 10.2.8.
Fuji Xerox Plugin Installer - The plug-in install package for Mac OS X 10.3.9 and 10.4.
Fuji Xerox PS Utility - Enables remote configuration of the printer from your Mac OS 
computer.
Adobe Screen Fonts - Contains screen fonts (17 TrueType fonts and 117 PostScript 
fonts) that are standard for PostScript 3 printers. It also contains 37 PostScript fonts for 
the Central European (CE) character codes.
ATM (Adobe Type Manager) ver. 4.5.2 - Allows you to install font typefaces and 
activate and manage fonts.
Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing 
platforms.
Readme.txt - Describes the precautions that must be followed when using the print 
drivers. Be sure to read this before using the print drivers.

Software/Hardware Requirements
The system requirements for the print drivers and utility for Mac OS are as follows:

Computer System
• Macintosh

• Power Macintosh

Print Driver
• AdobePS 8.5.2 - Mac OS 7.6.1 through 8.1

• AdobePS 8.7 - Mac OS 8.5 and 8.5.1

• AdobePS 8.8 - Mac OS 8.6 through 9.2.2

PPD Install/Plug-in Install Package
• Fuji Xerox PPD Installer - Mac OS X 10.1.5 and 10.2.8

• Fuji Xerox Plugin Installer - Mac OS X 10.3.9 and 10.4

Utility
• Fuji Xerox PS Utility - Mac OS 7.6.1 or later
NOTE: Fuji Xerox PS Utility runs in the Classic environment on Mac OS X.
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Installing the Print Driver 

This section describes how to install a AdobePS print driver on Mac OS 7.6.1 through 
9.x and how to add the printer on Mac OS X 10.1.5, 10.2.8, 10.3.9, or 10.4.
NOTE: You do not need to install a PostScript print driver on Mac OS X. A PostScript 
print driver is already installed as a part of Mac OS X.

Installation Procedure (Mac OS 9.x or Earlier)
The following explains how to install a AdobePS print driver on Mac OS 9.x or earlier.
The following procedure uses AdobePS 8.8 as an example.

1. Start Mac OS 9.x or earlier.

2. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 

The [FXOPS-PS] icon appears on your desktop.

3. Double-click the [FXOPS-PS] icon. 
The [FXOP-PS] window appears.

4. Double-click the folder for your printer model and then the “AdobePS880” folder. 

5. Double-click [AdobePS Installer 8.8].
The installer launches.

6. Click [Continue]. 
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7. Read the license agreement. If you agree, click [Accept]. 

Read "Read Me" and click [Continue].

8. Verify the installation location, change it if necessary, and click [Install].

The installation begins.
When the installation is complete, the following dialog box appears.

9. Click [Continue] or [Quit]. 

This completes the installation of the print driver.
Proceed to Configuring the PPD File (Mac OS 9.x or Earlier) on page 75 to configure 
the PPD file on the print driver.
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Configuring the PPD File (Mac OS 9.x or Earlier)
When you are finished installing the AdobePS print driver, configure the PostScript 
Printer Description (PPD) file onto the print driver.
The print driver controls the printer’s features based on the information stored in the 
PPD file.

When Using EtherTalk

1. Make sure that the printer is switched on.

2. Make sure that the printer’s EtherTalk port is set to [Enable].

NOTE: See the User Guide on how to enable the EtherTalk port. 

3. From the [Apple] menu, select [Chooser], and then click [AdobePS].

4. In Chooser, select the printer from the [Select a PostScript Printer] list box, and 
then click [Create].
NOTE: The displayed window may vary depending on the connection 
environment of the printer and a host device.

NOTE: The default printer name for the DocuPrint C3055/C3055 DX is 
"FXnnnnnn" (where nnnnnn is the last six digits of the printer’s MAC address).

The printer is searched automatically and the PPD file is configured.
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If the PPD File was Not Found Automatically:
(1) The [Select a PostScriptTM Printer Description File] dialog box appears.
(2) Select the PPD file for your printer model and click [Select]. 

The PPD file is configured.

5. In Chooser, select [Create] to set the options installed on the printer.

NOTE: You can change the option settings even after the installation of the print 
driver.
To use the features of the options, you must set [Installable Options]. Normally, 
[Installable Options] is set automatically via bi-directional communication with the 
printer and you do not need to change the settings. 

6. Click [Configure].

7. Set the options installed on the printer.

For information on how to set the options, see Configuring the Print Driver on page 
86.

8. Click [OK]. 
Click [OK] again in the next window.

9. Close Chooser.
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When Using the USB Port

1. When a USB cable is connected to your printer, disconnect it.

2. Make sure that your computer is switched on and switch the printer off.

3. Connect your computer and the printer with a USB cable.

4. Switch the printer on.

5. Double-click [Desktop Printer Utility].
[Desktop Printer Utility] launches and the [New Desktop Printer] dialog box 
appears.
NOTE: [Desktop Printer Utility] is stored in the "AdobePS Components" folder in 
your Macintosh hard disk.

6. From [With], select [AdobePS]. 
From [Create Desktop...], select [Printer (USB)]. 
Click [OK].

7. In [USB Printer Selection], click [Change...]. 
The [USB Printer] dialog box appears.
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8. Select your printer from [Select a USB Printer] and click [OK].

9. In [Post ScriptTM Printer Description (PPD) File], click [Auto Setup]. 
The [Select a Post ScriptTM Printer Description File] dialog box appears.

10. Select the PPD file for your printer model and click [Select].

The PPD file is configured.
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11. Click [Create...].

12. A dialog box asking if you want to save the changes appears. Click [Save] in the 
dialog box.

13. In the displayed dialog box, specify the printer’s name and installation location 
and click [Save]. 
Your settings are saved and the printer is created.

14. Set the options installed on the printer.

NOTE: You can change the option settings even after the installation of the print 
driver.
To use the features of the options, you must set [Installable Options]. Normally, 
[Installable Options] is set automatically via bi-directional communication with the 
printer and you do not need to change the settings. 

Installation Procedure (Mac OS X)
The following descries how to install the PostScript Printer Description (PPD) file on 
Mac OS X 10.1.5, 10.2.8, 10.3.9, or 10.4.
To install the PPD file on Mac OS X 10.1.5 or 10.2.8, use Fuji Xerox PPD Installer.
On Mac OS X 10.3.9 and 10.4, use Fuji Xerox Plugin Installer.
The following procedure uses Mac OS X 10.3.9 as an example.
NOTE: You do not need to install a PostScript print driver on Mac OS X. A PostScript 
print driver is already installed as a part of Mac OS X.

1. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive.

The [FXOPS-PS] icon appears on your desktop.

2. Double-click the [FXOPS-PS] icon.

The [FXOPS-PS] window appears.

3. Double-click the [Mac OS X] folder.

The [Mac OS X] window appears. 

4. Open the folder for the version of your Mac OS X.
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5. Double-click the [Fuji Xerox Plugin Installer] program icon.

The installer launches and the [Authenticate] window appears.

6. Enter the administrator’s user name and password, and then click [OK].

The license agreement appears.

7. Read the license agreement. If you agree, click [Accept].

8. Verify the installation location, change it if necessary, and click [Install].

9. A dialog box that informs you that the installation is complete appears. Click [Quit] 
in the dialog box.

This completes the installation of the PPD file.
Proceed to Adding the Printer (Mac OS X) on page 81 to configure the PPD file on the 
print driver.
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Adding the Printer (Mac OS X)
When you are finished installing the PPD file, configure the PPD file on the print driver 
and add the printer. 
The print driver controls the printer’s features based on the information stored in the 
PPD file.

1. If using the USB port, perform the following. 
If you are not using the USB port, proceed to Step 2.
1) If a USB cable is connected to your printer, disconnect it.
2) Make sure that your computer is switched on and switch the printer off.
3) Connect your computer and the printer with a USB cable.
4) Switch the printer on.

2. Check the port status of the printer. 

-  When using AppleTalk, set the EtherTalk port to [Enable].
-  When using IP Printing, set the LPD port to [Enable].
-  When using USB, set the USB port to [Enable].
NOTE: See the User Guide on how to enable each port.

3. Start [Print Setup Utility]. 

NOTE: On Mac OS X 10.1.5 through 10.2.8, start [Printer Center]. [Print Center] 
or [Printer Setup Utility] is in the "Utilities" folder under the "Applications" folder. 

The [Printer List] window appears.

4. Click [Add].

5. Select the protocol to be used to connect to the printer.
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Procedure (Mac OS X 10.1.5 through 10.3.9)
The following procedure uses Mac OS X 10.3.9 as an example.

When Using AppleTalk 

1. Select [AppleTalk] from the menu, and specify the zone where the printer is 
located.

2. Select the printer from the list.

NOTE: The default printer name for the DocuPrint C3055/C3055 DX is 
"FXnnnnnn" (where nnnnnn is the last six digits of the printer’s MAC address).

3. From [Printer Model], select [Auto Select] and proceed to Step 6.
If the PPD file for your printer was not found automatically, select [Other...] and 
proceed to Step 4.
The [Choose a File] dialog box appears.

4. Display "/Library/printers/PPDs/Contents/Resources/en.lpoj"

5. Select the PPD file for your printer model and click [Choose]. 

6. Click [Add].

When Using IP Printing

1. Select [IP Printing] from the menu, and enter the printer’s IP address in [Printer 
Address].
NOTE: On Mac OS X 10.3.3 through 10.3.9, select [LPD/LPR] from [Printer Type].
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2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer model.

3. Click [Add].

When Using USB

1. Select [USB] from the menu, and select the printer you want to use from the list.

2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer model.

3. Click [Add].

When Using Rendezvous (Mac OS X 10.2 and 10.3 Only)

1. Select [Rendezvous] from the menu, and select the printer you want to use from 
[Name].

2. From [Printer Model], select [FX]. 
From [Model Name], select the PPD file for your printer model.

3. Click [Add].



Installation and Configuration on Mac OS

84

Procedure (Mac OS X 10.4)
When Using AppleTalk, USB, or Bonjour
NOTE: If you switch the printer on after connecting a USB cable, the printer will be 
added automatically to the list. In such case, manually delete the printer from the list, 
and add it using the following procedure.

1. In the [Printer Browser] window, select [Default Browser].
The printers available on the AppleTalk, USB, and Bonjour ports are displayed.

2. Select the printer you want to use from the list.

3. Make sure that the printer is selected in [Print Using].
When the printer is not selected, select [FX] in [Print Using]. From the list of model 
names, select the PPD file for your printer model.
NOTE: The default printer name for the DocuPrint C3055/C3055 DX when using 
AppleTalk is "FXnnnnnn" (where nnnnnn is the last six digits of the printer’s MAC 
address).

4. Click [Add].

5. In the displayed window, set the options installed on the printer and click 
[Continue].
NOTE: The option settings can be configured also after adding the printer.
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When Using IP

1. In the [Printer Browser] window, select [IP Printer].

2. From the [Protocol] menu, select [Line Printer Deamon - LPD] and enter the IP 
address of the printer in [Address].

3. Verify that the printer is selected in [Print Using].
When the printer is not selected, select [FX] in [Print Using]. From the list of model 
names, select the PPD file for your printer model.

4. Click [Add].

5. In the displayed window, set the options installed on the printer and click 
[Continue].
NOTE: The option settings can be configured also after adding the printer.

This completes the addition of the printer.

About the Printer Options
On Mac OS X 10.2.x, click [Printers] on the [Print Center] menu bar, and select [Show 
Info].
On Mac OS X 10.3.3 through 10.3.9, click [Printers] on the [Printer Setup Utility] menu 
bar, and select [Show Info].
Next, select [Installable Options] and select the options installed on the printer. See 
Configuring the Print Driver on page 86 for how to set the options.
On Mac OS X 10.1.5, the printer’s options cannot be set on the print driver. The driver 
assumes all options are installed and thus the features for all options are selectable. 
Make sure to set the features only for the options that are actually installed on the 
printer.
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Configuring the Print Driver

This section describes how to configure [Installable Options], [Printer Specific Options] 
(Mac OS 9.x or earlier)/[Printer Features] (Mac OS X), [Secure Print/Sample Print] 
(Mac OS X 10.3.9/10.4 only), and [Job Accounting] (Mac OS X 10.3.9/10.4 only).

Installable Options

Procedure (Mac OS 9.x or Earlier)
The following explains how to configure [Installable Options] on Mac OS 9.x or earlier.
NOTE: Normally, [Installable Options] is set automatically via bi-directional 
communication with the printer and you do not need to change the settings.

1. Select the printer in Chooser and click [Setup].

The [Current Printer Description File (PPD) Selected] dialog box appears.

2. Click [Configure].

The [Installable Options] list appears.

3. Configure [Installable Options] and click [OK]. 
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Procedure (Mac OS X)
The following explains how to configure [Installable Options] on Mac OS X.

1. On Mac OS X 10.2.8, click [Printers] on the [Print Center] menu bar, and select 
[Show Info].
On Mac OS X 10.3.3 through 10.3.9, click [Printers] on the [Printer Setup Utility] 
menu bar, and select [Show Info].
NOTE: On Mac OS X 10.1.5, the printer’s options cannot be set on the print 
driver. The driver assumes all options are installed and thus the features for all 
options are selectable. Make sure to set the features only for the options that are 
actually installed on the printer.

2. Select [Installable Options] and set the options installed on the printer. 

Setting Items
Memory - Sets the memory capacity of the printer. 
Paper Tray Configuration - Sets the paper tray configuration of the printer.
Hard Disk - Sets whether or not the hard disk is installed in the printer. 
Duplex Module - Sets whether or not the duplex unit is installed in the printer.
NOTE: The duplex unit comes standard on the DocuPrint C3055 DX. If your printer is 
C3055 DX, [Duplex Module] does not appear under [Installable Options].
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Printer Specific Options/Printer Features

Procedure (Mac OS 9.x or Earlier)
The following explains how to configure [Printer Specific Options] on Mac OS 9.x or 
earlier.

1. On an application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Printer Specific Options].

3. Set the desired features.
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Procedure (Mac OS X)
The following explains how to configure [Printer Features] on Mac OS X.

1. On an application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Printer Features].

3. Set the desired features.
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Setting Items 
The following explains the items in [Printer Specific Options] and [Printer Features]. 
The displayed items vary depending on the options installed on the printer. Make sure 
to set these items after configuring [Installable Options]. For details on [Installable 
Options], see Installable Options on page 86.
Paper Type/Media - Sets the type of paper to be used when printing your document. 
Selecting [None] uses the paper type selected on the printer.
NOTE: On Mac OS X, [Paper Type/Media] appears when [Feature Sets] is set to [Set 
1].

Gray Guaranteed - Selecting the check box prints achromatic colors in black. This 
does not apply to images.
NOTE: On Mac OS X, [Gray Guaranteed] appears when [Feature Sets] is set to [Set 
1].

Bypass Feed Orientation - Sets the orientation of the paper when printing from the 
bypass tray. When loading the paper with one of the short edges facing into the bypass 
tray, select [Portrait]. When loading the paper with one of the long edges facing into the 
bypass tray, select [Landscape]. If the orientation can only be one way or the other 
depending on the paper size, the actual orientation of the paper overrides this setting. 
NOTE: On Mac OS X, [Bypass Feed Orientation] appears when [Feature Sets] is set 
to [Set 1].

Feed Separators from - Sets the paper tray for separators when using the 
Transparency Separators feature. Selecting [Auto] uses the paper tray selected on the 
printer.
NOTE: On Mac OS X, [Feed Separators from] appears when [Feature Sets] is set to 
[Set 1].

Print on Separators - Sets whether or not to print on separators. Selecting [Off] inserts 
blank separators. Selecting [On] prints the same contents printed on transparencies to 
separators.
NOTE: On Mac OS X, [Print on Separators] appears when [Feature Sets] is set to [Set 
1].

Substitute Tray - Sets what action to take when the paper of the size you requested 
is not loaded in the printer.

Use Printer Settings - Uses the settings configured on the printer. 
Display Message - Displays a message on the control panel that prompts you to 
load the paper. Your document will not be printed until you load the paper in the 
printer.
Use Nearest Size (Adjust to Fit) - Uses the paper of the nearest size and prints the 
document at 100% magnification or at a reduced magnification if necessary. 
Use Nearest Size (No Zoom) - Uses the paper of the nearest size and prints the 
document at 100% magnification.
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Use Larger Size (Adjust to Fit) - Uses the paper of a larger size and prints the 
document at 100% magnification or at a reduced magnification if necessary.
Use Larger Size (No Zoom) - Uses the paper of a larger size and prints the 
document at 100% magnification.
Feed from Bypass Tray - Feeds the paper from the bypass tray when it is not 
loaded in the paper trays.

NOTE: On Mac OS X, [Substitute Tray] appears when [Feature Sets] is set to [Set 1].

Custom Paper Auto Orientation - If printing on user-defined paper, selecting [On] 
corrects the orientation of the paper. If your document was printed 90 degrees rotated 
on the paper, set this feature to [On].
NOTE: On Mac OS X, [Custom Paper Auto Orientation] appears when [Feature Sets] 
is set to [Set 2].

Draft Mode - Selecting [On] prints with less toner and thus the colors become lighter. 
Use this feature to save toner when printing documents that do not require high image 
quality.
NOTE: On Mac OS X, [Draft Mode] appears when [Feature Sets] is set to [Set 2].

Skip Blank Pages - Sets whether or not to skip blank pages during printing.
NOTE: On Mac OS X, [Skip Blank Pages] appears when [Feature Sets] is set to [Set 
2].

Halftone Screen Lock - Sets halftone screens. Selecting [On] prioritizes the settings 
on the printer over the settings on the application.
NOTE: On Mac OS X, [Halftone Screen Lock] appears when [Feature Sets] is set to 
[Set 2].

Output Color - Sets whether to print in color or in monochrome. [Color] uses all CMYK 
(cyan/magenta/yellow/black) toners when printing. [Black and White] uses only the K 
(black) toner.
NOTE: On Mac OS X, [Output Color] appears when [Feature Sets] is set to [Set 2].

CID Font - Sets whether to use only CID fonts or both CID and OCF fonts. When using 
only CID fonts, select [CID Native]. When using both CID and OCF fonts, select [OCF 
Compatible].
NOTE:  [CID Font] appears only when the Japanese font kit (optional) is installed.

NOTE: On Mac OS X, [CID Font] appears when [Feature Sets] is set to [Set 2]. 

Print Mode - Sets whether to print in [High Speed] or [High Quality] mode. 
NOTE: On Mac OS X, [Print Mode] appears when [Feature Sets] is set to [1. 
Graphics].

Brightness - Sets the overall brightness of the output.
NOTE: On Mac OS X, [Brightness] appears when [Feature Sets] is set to [1. 
Graphics].
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Image Type - Sets the type of your document.
Standard - Optimizes the printing of business documents that consist of texts and 
graphs.
Photos - Suitable for printing photographic images and optimizes the reproduction 
of gradations. This is ideal for images represented in sRGB. 
Presentation - Suitable for printing presentation materials that need vibrant colors.
Web Pages - Suitable for printing the contents displayed on your computer screen, 
such as web pages.
Off - Does not perform color correction.

NOTE: On Mac OS X, [Image Type] appears when [Feature Sets] is set to [1. 
Graphics].

Screen - Adjusts the image quality of your document. 
Auto - Automatically adjusts the image quality based on the type of the document.
Fineness - Optimizes the reproduction of texts and lines.
Standard - Optimizes the reproduction of photographic images.
Gradation - Optimizes the reproduction of charts and graphs.

NOTE: On Mac OS X, [Screen] appears when [Feature Sets] is set to [1. Graphics].

Adjust Color Balance - Selecting the check box adjusts the density of the CMYK 
(cyan/magenta/yellow/black) toners. The density of each toner can be adjusted in [Low 
Density], [High Density], and [High Density] under [3. Color Balance C], [4. Color 
Balance M], [5. Color Balance Y], and [6. Color Balance K]. 
NOTE: On Mac OS X, [Adjust Color Balance] appears when [Feature Sets] is set to [1. 
Graphics].

RGB Color Correction - Sets the color correction method for the RGB images on your 
document. 

Perceptual - Optimizes the rendering of photographic images by preserving all tonal 
gradations.
Saturation - Optimizes the rendering of business graphics by preserving the 
saturation of colors.
Relative Colorimetric - Preserves in-gamut colors and represents out-of gamut 
colors by the closest match.
Absolute Colorimetric - Does not map the white in the images to the white of the 
output paper. Depending on the [RGB Color Temperature] setting, the white in the 
images may be printed with a tint of color.

NOTE: On Mac OS X, [RGB Color Correction] appears when [Feature Sets] is set to 
[2. Color Adjustment]. This feature is not supported on Mac OS X 10.1.5.

RGB Profile - Sets RGB profile. The [RGB profile] setting will be applied in conjunction 
with the [RGB Color Correction] setting. [Adobe RGB (1998)] is the RGB profile of 
Adobe Systems Incorporated. [Adobe RGB (1998)] may not accurately reproduce the 
tones of highly saturated graphics.
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NOTE: On Mac OS X, [RGB Profile] appears when [Feature Sets] is set to [2. Color 
Adjustment]. This feature is not supported on Mac OS X 10.1.5.

RGB Gamma Correction - Adjusts the brightness of the RGB images on your 
document. Select a value depending on the monitor being used. The larger the value, 
the darker the output.
NOTE: On Mac OS X, [RGB Gamma Correction] appears when [Feature Sets] is set 
to [2. Color Adjustment]. This feature is not supported on Mac OS X 10.1.5.

RGB Color Temperature - Adjusts the color temperature of your monitor to match the 
on-screen colors to the printed output colors.

5000K(D50) - Colors become slightly more yellowish than [6500K (D65)].
9300K - Colors become slightly more bluish than [6500K (D65)].

NOTE: On Mac OS X, [RGB Color Temperature] appears when [Feature Sets] is set to 
[2. Color Adjustment]. This feature is not supported on Mac OS X 10.1.5.

Low Density, Medium Density, High Density - Fine-tunes the density of the CMYK 
(cyan/magenta/yellow/black) toners.
NOTE: On Mac OS X, [Low Density], [Medium Density], and [High Density] appear 
when [Feature Sets] is set to [3. Color Balance C], [4. Color Balance], or [5. Color 
Balance]. This feature is not supported on Mac OS X 10.1.5.

Secure Print/Sample Print (Mac OS X 10.3.9/10.4 Only)
The following explains how to configure [Secure Print/Sample Print] on Mac OS X 
10.3.9 or 10.4.

1. On an application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Secure Print/Sample Print].
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3. Set the desired features.

Setting Items 
The following explains the items that appear on the [Secure Print/Sample Print] tab on 
Mac OS X 10.3.9 or 10.4.
NOTE: Clicking the [Restore Defaults] button restores the defaults.

Job Type - Sets the type of your print job to [Normal Print], [Secure Print], or [Sample 
Print].

Normal Print - Prints a job without using the Secure Print or Sample Print feature.
Secure Print - Temporarily stores a print job in the printer, rather than printing it 
immediately, until you manually start the printing from the control panel.
Sample Print - Allows you to print a proof copy of a multi-set job and prints the entire 
sets once the print result has been verified. If you set the print quantity to 1, this 
setting automatically changes to [Normal Print].

User ID - Sets the user ID for the Secure Print or Sample Print feature with up to 8 
alphanumeric characters.
Password - Sets the password for the user ID with up to 12 alphanumeric characters. 
Asterisks (***) appear instead of text as you enter the password in this text box.
Retrieve Document Name - Sets the method of specifying the name of the document 
that will be stored in the printer using the Secure Print or Sample Print feature. [Auto 
Retrieve] automatically retrieves the document name from the application from which 
the document will be printed. If the name exceeds 12 alphanumeric characters, only 
the first 12 characters will be valid. 
Document Name - [Retrieve Document Name] is set to [Enter Document Name], enter 
the document name with up to 12 alphanumeric characters.
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Job Accounting (Mac OS X 10.3.9/10.4 Only)
The following explains how to configure [Job Accounting] on Mac OS X 10.3.9 or 10.4.

1. On an application, click [Print] from the [File] menu.

The [Print] dialog box appears.

2. Select [Job Accounting].

3. Set the desired features.

Setting items 
The following explains the items that appear on the [Job Accounting] tab on Mac OS X 
10.3.9 or 10.4.
Account Mode - Sets whether to allow all users or only the administrator to change the 
login settings. 
Detailed User Settings - Displays the [Detailed User Settings] dialog box.

Use Login Settings - Uses your Macintosh login ID as the job owner name. Clicking 
the button enters the Macintosh login ID in [Job Owner Name] and makes it unable 
to change. If the ID exceeds 32 characters, only the first 32 characters will be valid.
Job Owner Name - Sets the job owner name with up to 32 alphanumeric 
characters.
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Password - Sets the password for the job owner name using 4 to 12 alphanumeric 
characters.

Installing the Screen Fonts

This section describes how to install the fonts included in the "Screen Font" folder.
Close all other applications before starting the installation. Otherwise, a warning 
message appears between Steps 5 and 6.

1. Start your Macintosh computer and insert the PostScript Driver Library CD-ROM 
into the CD-ROM drive.

2. Double-click the [FXOPS-PS] icon followed by the "Screen Font" folder and then 
[PS3 Fonts Installer]. The following window appears. 

3. Click [Continue].

The license agreement appears.

4. Read the license agreement. If you agree, click [Accept].

The [PS3FontsInstaller] dialog box appears.
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5. Select [Easy Install] or [Custom Install].

Easy Install - Installs all fonts in the "Screen Font" folder. 

Custom Install - Installs the selected fonts only. Click the triangle next to each font 
category to display the fonts within the category, and select the fonts you want to 
install. In this example, we will select [Arial CE] under [CE TrueType]. 

A warning message appears if you did not close other applications before starting 
the installation.

6. Click [Install].

The installation begins.
When the installation is complete, reboot your computer.
Store the CD-ROM in a safe place.



Installation and Configuration on Mac OS

98

Fuji Xerox PS Utility

Fuji Xerox PS Utility enables remote configuration of the printer from your Macintosh 
computer. This section describes how to install, uninstall, and use Fuji Xerox PS Utility.
NOTE: To use Fuji Xerox PS Utility, make sure to set the printer’s EtherTalk port to 
[Enable] and set the printer correctly in Chooser. See the User Guide on how to 
enable the EtherTalk port.

Installing Fuji Xerox PS Utility 

1. Insert the PostScript Driver Library CD-ROM into your CD-ROM drive. 

The [FXOPS-PS] icon appears on your desktop.

2. Double-click the [FXOPS-PS] icon.

The [FXOPS-PS] window opens.

3. Copy the "Fuji Xerox PS Utility" folder to your Macintosh hard disk.

The Fuji Xerox PS Utility is installed.
For information on how to use Fuji Xerox PS Utility, see Using Fuji Xerox PS Utility on 
page 98.
Store the CD-ROM in a safe place.

Uninstalling Fuji Xerox PS Utility

1. Move the "Fuji Xerox PS Utility" folder from your Macintosh hard disk to the 
[Trash] icon.
The Fuji Xerox PS Utility is uninstalled.

Using Fuji Xerox PS Utility
The following explains how to activate and configure Fuji Xerox PS Utility.
Fuji Xerox Print Utility allows you to configure the printer’s system, paper feeding, and 
paper delivery settings. It also allows you to download PS files to the printer and set the 
printer’s name and EtherTalk zone.
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Activating Fuji Xerox PS Utility

1. Double-click [Fuji Xerox PS Utility] in the "Fuji Xerox PS Utility" folder.
The [Fuji Xerox PS Utility] main window appears. 
Operate the window using the menu bar and buttons.

To exit Fuji Xerox PS Utility, click [Quit] on the [File] menu. 

Configuring the Printer Settings

1. Configure the printer settings.

NOTE: For details on each setting item, click [Help].

Download PS File - Select [Download PS file] from the [File] menu.
This feature allows you to download PostScript files to the printer. Select the file you 
want to download and click [Open]. 
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Printer Name - Select [Printer Name] from the [Settings] menu. The [Printer Name 
Settings] dialog box appears. In the dialog box, set a name for the printer. 
.

EtherTalk - Select [EtherTalk] from the [Settings] menu. The [EtherTalk Zone 
Settings] dialog box appears. In the dialog box, verify the current zone or change 
the zone.

.

2. When you are finished setting each item, click [OK].

The printer settings are updated and you will return to the main menu.
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5 Barcode Settings

This chapter includes the following information:

• About Barcodes
– Font Types and Character Codes
– Sample Program and Output Result

• Character Code Tables
– JAN Character Code Table
– Code 39 Character Code Table
– NW7 Character Code Table
– Code 128 Character Code Table
– ITF (Interleaved 2 of 5) Character Code Table
– Customer Barcode Character Code Table

• Barcode Sizes

About Barcodes

This section describes the supported types of barcodes, the character codes assigned 
to each barcode character, and the size of barcodes that can be printed. The barcode 
feature comes standard on the DocuPrint C3055 DX and is available on the DocuPrint 
C3055 if the PostScript software kit is installed. 
NOTE: This chapter assumes you have basic knowledge of barcodes.

Font Types and Character Codes
The following table lists the supported types of barcodes.
For information about the character codes used to specify each barcode character, see 
Character Code Tables on page 103.
For information about the sizes of barcodes that can be printed, see Barcode Sizes on 
page 113.

Barcode Type PostScript Font Name Character Code

JAN HitachiITHINJANH8-RG "JAN Character Code Table" (P. 103)

Code 39 HitachiIT-C39H8 "Code 39 Character Code Table" (P. 
104)
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NOTE: The readability of barcodes is affected largely by the quality of the output 
paper and the performance of barcode readers.
Before using this feature, we recommend you to test it thoroughly in the environment it 
will be used.

Sample Program and Output Result
The Barcode feature provides a sample program that prints a typical barcode and a 
PDF file of its output result. Use this sample as a reference when printing barcodes. 

❥ Directory of the Sample Program/Output Result (PDF) 
"manual" folder > "sample" folder on the PostScript Driver Library CD-ROM

❥ Name of the Sample Program
Sample.ps

❥ PDF File Name of the Output Result
Sample.pdf

NW7 HitachiITHINNW7H8-RG "NW7 Character Code Table" (P. 105)

Code 128 HitachiITHINC128H8-RG "Code 128 Character Code Table" (P. 
106)

ITF
(without bearer bars)

HitachiITHINITFH8-RG "ITF (Interleaved 2 of 5)
Character Code Table" (P. 110)

ITF
(with bearer bars)

HitachiITHINITFB-RG

Customer Barcode HitachiITHINPOSTBC-RG "Customer Barcode Character Code 
Table"(P. 112)

Barcode Type PostScript Font Name Character Code

Font Type PostScript Font Name

OCR B LetterPress M OCRBLetM



Barcode Settings

103

Character Code Tables

This section describes the character codes used when specifying each barcode 
character. 

JAN Character Code Table
The table below lists the characters codes used when printing JAN barcode characters.

Character

Character Code

Left-side Odd Parity Left-side Even Parity Right-side Even Parity

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

0 30 0 41 A 4B K

1 31 1 42 B 4C L

2 32 2 43 C 4D M

3 33 3 44 D 4E N

4 34 4 45 E 4F O

5 35 5 46 F 50 P

6 36 6 47 G 51 Q

7 37 7 48 H 52 R

8 38 8 49 I 53 S

9 39 9 4A J 54 T

Left-side 
guard bar

22 "

Right-side 
guard bar

23 #

Center bar 21 !
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Code 39 Character Code Table

The table below lists the characters codes used when printing Code 39 barcode 
characters.

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

$ 24 $ 8 38 8 M 4D M

% 25 % 9 39 9 N 4E N

* 2A * (SP) 20 SP O 4F O

+ 2B + A 41 A P 50 P

- 2D - B 42 B Q 51 Q

. 2E . C 43 C R 52 R

/ 2F / D 44 D S 53 S

0 30 0 E 45 E T 54 T

1 31 1 F 46 F U 55 U

2 32 2 G 47 G V 56 V

3 33 3 H 48 H W 57 W

4 34 4 I 49 I X 58 X

5 35 5 J 4A J Y 59 Y

6 36 6 K 4B K Z 5A Z

7 37 7 L 4C L (SP) 40 @
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NW7 Character Code Table
The table below lists the characters codes used when printing NW7 barcode 
characters.

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

$ 24 $ 0 30 0 A 41 A

+ 2B + 1 31 1 B 42 B

- 2D - 2 32 2 C 43 C

. 2E . 3 33 3 D 44 D

/ 2F / 4 34 4 A 61 a

5 35 5 B 62 b

6 36 6 C 63 c

7 37 7 D 64 d

8 38 8

9 39 9

: 3A :



Barcode Settings

106

Code 128 Character Code Table
The table below lists the characters codes used when printing Code 128 barcode 
characters.

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation

0 SP SP 00 20 SP

1 ! ! 01 21 !

2 " " 02 22 "

3 # # 03 23 #

4 $ $ 04 24 $

5 % % 05 25 %

6 & & 06 26 &

7 ' ' 07 27 '

8 ( ( 08 28 (

9 ) ) 09 29 )

10 * * 10 2A *

11 + + 11 2B +

12 , , 12 2C ,

13 - - 13 2D -

14 . . 14 2E .

15 / / 15 2F /

16 0 0 16 30 0

17 1 1 17 31 1

18 2 2 18 32 2

19 3 3 19 33 3

20 4 4 20 34 4

21 5 5 21 35 5

22 6 6 22 36 6

23 7 7 23 37 7

24 8 8 24 38 8

25 9 9 25 39 9

26 : : 26 3A :

27 ; ; 27 3B ;

28 < < 28 3C <

29 = = 29 3D =
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30 > > 30 3E >

31 ? ? 31 3F ?

32 @ @ 32 40 @

33 A A 33 41 A

34 B B 34 42 B

35 C C 35 43 C

36 D D 36 44 D

37 E E 37 45 E

38 F F 38 46 F

39 G G 39 47 G

40 H H 40 48 H

41 I I 41 49 I

42 J J 42 4A J

43 K K 43 4B K

44 L L 44 4C L

45 M M 45 4D M

46 N N 46 4E N

47 O O 47 4F O

48 P P 48 50 P

49 Q Q 49 51 Q

50 R R 50 52 R

51 S S 51 53 S

52 T T 52 54 T

53 U U 53 55 U

54 V V 54 56 V

55 W W 55 57 W

56 X X 56 58 X

57 Y Y 57 59 Y

58 Z Z 58 5A Z

59 [ [ 59 5B [

60 \ \ 60 5C \

61 ] ] 61 5D ]

62 ^ ^ 62 5E ^

63 _ _ 63 5F _

64 NUL ` 64 60 `

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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65 SOH a 65 61 a

66 STX b 66 62 b

67 ETX c 67 63 c

68 EOT d 68 64 d

69 ENQ e 69 65 e

70 ACK f 70 66 f

71 BEL g 71 67 g

72 BS h 72 68 h

73 HT I 73 69 I

74 LF j 74 6A j

75 VT k 75 6B k

76 FF l 76 6C l

77 CR m 77 6D m

78 SO n 78 6E n

79 SI o 79 6F o

80 DLE p 80 70 p

81 DC1 q 81 71 q

82 DC2 r 82 72 r

83 DC3 s 83 73 s

84 DC4 t 84 74 t

85 NAK u 85 75 u

86 SYN v 86 76 v

87 ETB w 87 77 w

88 CAN x 88 78 x

89 EM y 89 79 y

90 SUB z 90 7A z

91 ESC { 91 7B {

92 FS | 92 7C |

93 GS } 93 7D }

94 RS ~ 94 7E ~

95 US DEL 95 7F DEL

96 FNC 3 FNC 3 96 A1

97 FNC 2 FNC 2 97 A2

98 SHIFT SHIFT 98 A3

99 CODE C CODE C 99 A4

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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100 CODE B FNC 4 CODE B A5

101 FNC 4 CODE A CODE A A6

102 FNC 1 FNC 1 FNC 1 A7

103 START(CODE A) A8

104 START(CODE B) A9

105 START(CODE C) AA

106 STOP AB

Value

Character Code Character Code

CODE A CODE B CODE C HEX 
Notation

ASCII 
Notation
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ITF (Interleaved 2 of 5) Character Code Table
The table below lists the characters codes used when printing ITF barcode characters.

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

00 21 ! 30 3F ? 60 5D ]

01 22 " 31 40 @ 61 5E ^

02 23 # 32 41 A 62 5F _

03 24 $ 33 42 B 63 60 `

04 25 % 34 43 C 64 61 a

05 26 & 35 44 D 65 62 b

06 27 ' 36 45 E 66 63 c

07 28 ( 37 46 F 67 64 d

08 29 ) 38 47 G 68 65 E

09 2A * 39 48 H 69 66 F

10 2B + 40 49 I 70 67 G

11 2C , 41 4A J 71 68 H

12 2D - 42 4B K 72 69 I

13 2E . 43 4C L 73 6A J

14 2F / 44 4D M 74 6B K

15 30 0 45 4E N 75 6C L

16 31 1 46 4F O 76 6D M

17 32 2 47 50 P 77 6E N

18 33 3 48 51 Q 78 6F O

19 34 4 49 52 R 79 70 P

20 35 5 50 53 S 80 71 Q

21 36 6 51 54 T 81 72 R

22 37 7 52 55 U 82 73 S

23 38 8 53 56 V 83 74 T

24 39 9 54 57 W 84 75 U

25 3A : 55 58 X 85 76 V

26 3B ; 56 59 Y 86 77 W

27 3C < 57 5A Z 87 78 X

28 3D = 58 5B [ 88 79 Y

29 3E > 59 5C \ 89 7A Z

90 7B { 94 A1 DEL 98 A5
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ITF barcodes represent a pair of a BAR character (character denoted with a bar) and a SPACE character (character 
denoted with a space) with one character code.
A single START character or STOP character is represented with one character code.

Example:
To print a pair of a BAR character representing “3” and a SPACE character representing “7”, specify “46” (HEX notation).
To print a pair of a BAR character representing “7” and a SPACE character representing “3”, specify “6A” (HEX 
notation).

91 7C | 95 A2 99 A6

92 7D } 96 A3 START A7

93 7E ~ 97 A4 STOP A8

Character

Character Code

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation
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Customer Barcode Character Code Table
The table below lists the characters codes used when printing customer barcode 
characters.

Character

Character Code

Character

Character Code

HEX 
Notation

ASCII 
Notation

HEX 
Notation

ASCII 
Notation

START 3C < CC1 61 a

STOP 3E > CC2 62 b

- 2D - CC3 63 c

0 30 0 CC4 64 d

1 31 1 CC5 65 e

2 32 2 CC6 65 f

3 33 3 CC7 67 g

4 34 4 CC8 68 h

5 35 5

6 36 6

7 37 7

8 38 8

9 39 9
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Barcode Sizes

The formulas for determining the approximate print sizes of barcodes are in the 
following table.
The print sizes of barcodes vary depending on the characteristics of the printer, print 
resolution, output paper, and other factors even when the same program is used. The 
sizes derived from the following formulas do not guarantee the actual sizes of 
barcodes. Use them only as reference.

P: Font size (point)
C: Number of characters
C1: Number of characters (0,1,2,3,4,5,6,7,8,9,-,$)
C2: Number of characters (:,/,.,+,A,B,C,D)

Barcodes
type

Formula

Width Height

JAN (standard) P × 0.502 P × 0.352

Side margins not included. Indicates the height of the guard bar.

JAN (short version) P × 0.354 P × 0.352

Side margins not included. Indicates the height of the guard bar.

Code 39 P × (C + 2) x 0.106 P × 0.352

Intercharacter gap of the left and right 
sides not included.
"C" includes the checkdigit.

NW7 P × (C1 × 0.132 + C2 × 0.148 - 0.026) P × 0.352

Intercharacter gap of the left and right 
sides not included.
“C1” and “C2” include the checkdigit.

Code 128 P × (C x 0.081 + 0.096) P × 0.352

Formula for CODE C.

ITF
(without bearer bar)

P × ((C/2 × 0.175) +0.093) P × 0.352

Quiet zone not included.
“C” includes the checkdigit.

ITF
(with bearer bar)

P × ((C/2 × 0.137) + 0.323) P × 0.352

Bearer bar and quiet zone included.
“C” includes the checkdigit.

Bearer bar included.

Customer Barcode P × 7.297 P × 0.342

Spaces before the black bar of START 
code and after the black bar of the STOP 
code are not included.

Indicates the height of the long bar.
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6 Appendix

Available Fonts

The PostScript fonts available on the printer are as follows.
NOTE: Installing the Japanese font kit to the printer allows you to use Japanese 
PostScript fonts (two MORISAWA fonts and two HEISEI fonts).

136 European Fonts and Barcode/OCR-B Fonts
Albertus

Albertus Italic

Albertus Light

Antique Olive Bold

Antique Olive Compact

Antique Olive Italic

Antique Olive Roman

Apple Chancery

Arial

Arial Bold

Arial Bold Italic

Arial Italic

Bodoni Bold

Bodoni Bold Italic

Bodoni Italic

Bodoni Poster

Bodoni Poster Compressed

Bodoni Roman

Carta

Chicago

Clarendon Bold

Clarendon Light

Clarendon Roman

Cooper Black

Cooper Black Italic
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Copperplate Gothic 32BC

Copperplate Gothic 33BC

Coronet

Courier

Courier Bold

Courier Bold Oblique

Courier Oblique

Eurostile Bold

Eurostile Bold Extended No. 2

Eurostile Extended No. 2

Eurostile Medium

Geneva

Gill Sans

Gill Sans Bold

Gill Sans Bold Italic

Gill Sans Condensed

Gill Sans Condensed Bold

Gill Sans Extra Bold

Gill Sans Italic

Gill Sans Light

Gill Sans Light Italic

Goudy Bold

Goudy Bold Italic

Goudy Extra Bold

Goudy Oldstyle

Goudy Oldstyle Italic

Helvetica

Helvetica Bold

Helvetica Bold Oblique

Helvetica Condensed

Helvetica Condensed Bold

Helvetica Condensed Bold Oblique

Helvetica Condensed Oblique

Helvetica Narrow

Helvetica Narrow Bold

Helvetica Narrow Bold Oblique
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Helvetica Narrow Oblique

Helvetica Oblique

Hoefler Ornaments

Hoefler Text

Hoefler Text Black

Hoefler Text Black Italic

Hoefler Text Italic

ITC Avant Garde Gothic Book

ITC Avant Garde Gothic Book Oblique

ITC Avant Garde Gothic Demi

ITC Avant Garde Gothic Demi Oblique

ITC Bookman Demi

ITC Bookman Demi Italic

ITC Bookman Light

ITC Bookman Light Italic

ITC Lubalin Graph Book

ITC Lubalin Graph Book Oblique

ITC Lubalin Graph Demi

ITC Lubalin Graph Demi Oblique

ITC Mona Lisa Recut

ITC Zapf Chancery Medium Italic

ITC Zapf Dingbats

Joanna

Joanna Bold

Joanna Bold Italic

Joanna Italic

Letter Gothic

Letter Gothic Bold

Letter Gothic Bold Slanted

Letter Gothic Slanted

Marigold

Monaco

New Century Schoolbook Bold

New Century Schoolbook Bold Italic

New Century Schoolbook Italic

New Century Schoolbook Roman
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New York

Optima Bold

Optima Bold Italic

Optima Italic

Optima Roman

Oxford

Palatino Bold

Palatino Bold Italic

Palatino Italic

Palatino Roman

Stempel Garamond Bold

Stempel Garamond Bold Italic

Stempel Garamond Italic

Stempel Garamond Roman

SymbolTekton Regular

Times BoldTimes Bold Italic

Times ItalicTimes Roman

Times New Roman

Times New Roman Bold

Times New Roman Bold Italic

Times New Roman Italic

Univers 45 Light

Univers 45 Light Oblique

Univers 53 Extended

Univers 53 Extended Oblique

Univers 55Univers 55 Oblique

Univers 57 Condensed

Univers 57 Condensed Oblique

Univers 63 Extended Bold

Univers 63 Extended Bold Oblique

Univers 65 Bold

Univers 65 Bold Oblique

Univers 67 Condensed Bold

Univers 67 Condensed Bold Oblique

Wingdings

OCR-B Letterpress M
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Hitachi-IT Barcode Code39 H8

Hitachi-IT Barcode Code128 H8

Hitachi-IT Barcode ITFB

Hitachi-IT Barcode ITF H8

Hitachi-IT Barcode JAN H8

Hitachi-IT Barcode NW-7 H8

Hitachi-IT Barcode POSTBC

Notes and Restrictions

Print Driver
The notes and restrictions that apply to each Post Script print driver is described in 
"Readme.txt" in the PostScript Driver Library CD-ROM. Make sure to read the file 
before installing the print driver to your computer.

Troubleshooting
Refer to the User Guide for the error codes and error messages that appear on the 
control panel and for instructions on how to clear paper jams.
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7 Index

A

Adobe Acrobat Reader ..11, 30, 49, 72
Adobe Type Manager (ATM) 
...................................................... 11, 29, 72
AdobePS print driver (ver. 5.2.2) ...29
AdobePS print driver (ver. 8.5.1, 
8.7.0, and 8.8) ......................................71
AdobePS print driver (ver.4.5.3) .....11
Advanced tab ................................ 40, 62

B

barcode ................................................101
barcode sizes .....................................113

C

Code 128 character code table ....106
Code 39 character code table .......104
Color Settings tab ...............................23
Configuration tab ................... 18, 38, 60
Customer Barcode character code 
table ......................................................112

D

Device Settings tab ..................... 37, 59
Download PS File ...............................99

E

error codes ..........................................119
error messages .................................119
EtherTalk .............................................100

F

fonts, supported ................................115
Fuji Xerox PPD Installer ....................72
Fuji Xerox PS Utility .................... 72, 99

I

Image Options tab .............................. 66
Installable Options .............................. 86

J

JAN character code table ............... 103

L

Layout tab .............................................68

M

Mac OS 9.x or earlier .........................86
Mac OS X ........................................87, 89

N

notes and restrictions ......................119
NW7 character code table .............105

O

online help ............................................69
Options tab ........................................... 22
Output Settings tab ............................25

P

Paper/Output tab ................................64
PPD .....................................11, 29, 49, 71
Printer Features ..................................88
Printer Name ......................................100
Printer Specific Options ....................88

R

Readme.txt ........................11, 30, 49, 72
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S

screen fonts ....................................72, 96
supported fonts ................................. 115

W

Windows 2000 ..................................... 49
Windows 95 .......................................... 12
Windows 98 .......................................... 12
Windows Me ........................................ 12
Windows NT 4.0 ................................. 29
Windows Server 2003 ....................... 49
Windows XP ......................................... 49
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